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Abstract- A forklift is a versatile industrial vehicle used for lifting, transporting, and stacking materials. 

Available in electric, diesel, and gas-powered models, forklifts enhance efficiency and reduce injury risks in 

various environments. Electric models are ideal for indoor use, while gas-powered ones excel outdoors. 

Modern advancements include remote control capabilities for increased safety and precision. Using materials 

like mild steel ensures minimal fork deformation. Forklifts can lift to 500 kg at an ITA rating of 990.6 mm 

and 1016 mm. Future developments will focus on ergonomic design, lightweight materials, safety features, 

hybrid models, and smart technology integration. 
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1. INTRODUCTION  

A forklift is a versatile and powerful industrial vehicle essential for lifting, transporting, and stacking materials 

over short distances. Resembling a small truck, it is equipped with two metal forks at the front designed to 

handle heavy loads with ease. Forklifts are widely used in warehouses, construction sites, and manufacturing 

facilities, where they significantly improve efficiency and reduce the risk of injury. They come in various types, 

including electric, diesel, and gas-powered models, each tailored to specific environments and applications. 

Electric forklifts are ideal for indoor use due to their emission-free operation, while gasoline and propane 

forklifts offer greater speed and power for outdoor or heavy-duty tasks, albeit with higher maintenance and 

fuel costs. Rough terrain forklifts, built for construction sites and uneven surfaces, have the highest lifting 

capacities and robust tires to handle challenging conditions. The advent of forklifts has revolutionized 

material handling, enabling a single operator to move thousands of pounds safely and efficiently. Modern 

advancements have even introduced remote control capabilities, allowing operators to maneuver forklifts 

with greater precision and visibility, further enhancing safety and operational accuracy. Popular types of 

forklifts include warehouse forklifts, side loaders, counterbalance forklifts, telehandlers, and pallet jacks, 

among others, each serving unique purposes in diverse industrial applications. 
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1.1. Advantages of Forklift: 

Forklifts offer several advantages in various industries, particularly in warehousing, manufacturing, 

construction, and logistics. Here are some of the key benefits of using forklifts: 

a. Increased Efficiency and Productivity- Forklifts can move heavy loads quickly and efficiently, significantly 

speeding up the process of loading and unloading materials. Modern forklifts are equipped with advanced 

controls and navigation systems, allowing for precise handling of goods. 

b. Versatility- There are many types of forklifts designed for specific tasks, such as counterbalance forklifts, 

reach trucks, pallet jacks, and rough terrain forklifts. Forklifts can be fitted with various attachments (e.g., 

clamps, rotators, side shifters) to handle different types of loads. 

c. Safety- Forklifts reduce the need for manual lifting, lowering the risk of injuries associated with heavy 

lifting and repetitive strain. They are designed to safely lift and transport heavy loads, with features such as 

counterbalancing to prevent tipping. 

d. Cost-Effective- By increasing the speed and efficiency of material handling, forklifts can help reduce labor 

costs. High-quality forklifts are durable and can last many years with proper maintenance, offering a good 

return on investment. 

e. Handling Heavy Loads- Forklifts can handle very heavy loads, with some models capable of lifting several 

tons. They allow for the efficient stacking of goods, maximizing warehouse space. 

f. Improved Ergonomics- Modern forklifts are designed with operator comfort in mind, featuring ergonomic 

seats, controls, and easy-to-read displays. They minimize the physical strain on workers, contributing to a 

healthier work environment. 

g. Flexibility in Operations- Forklifts are suitable for both indoor and outdoor applications, with specific 

models designed to navigate different terrains. They can move easily through narrow aisles and tight spaces, 

enhancing their usability in confined areas. 

h. Adaptability to Different Work Environments- There are specialized forklifts for hazardous environments, 

such as explosion-proof models for use in chemical plants or other volatile settings. Many forklifts are built 

to operate in various weather conditions, ensuring continuous operation regardless of the environment. 

i. Technology Integration- Some modern forklifts come with automated features and AI integration, allowing 

for semi-autonomous or fully autonomous operation. Advanced forklifts can be equipped with telematics 

systems to monitor performance, and maintenance needs, and optimize fleet management. 

j. Environmentally Friendly Options- Electric models produce zero emissions, making them suitable for 

indoor use and environmentally conscious operations. Newer models are designed to be more energy-

efficient, reducing overall energy consumption and operational costs. 

By leveraging these advantages, businesses can improve their material handling processes, enhance safety, 

and boost overall productivity. 

1.2. Disadvantages of Forklift: 

While forklifts offer numerous advantages, they also come with certain disadvantages and challenges. Here 

are some of the key disadvantages associated with forklift use: 

a. Safety Risks- Forklifts can pose significant safety hazards if not operated correctly, including the risk of 

tipping over, collisions, and injuries to operators or bystanders. Mistakes by operators, such as improper 

loading, excessive speed, or lack of awareness, can lead to accidents. 

b. Operational Costs- The cost of purchasing a forklift can be high, especially for advanced models with 

additional features. Regular maintenance and repair costs can add up, particularly for older or heavily used 

http://www.ijcrt.org/


www.ijcrt.org                                                          © 2024 IJCRT | Volume 12, Issue 6 June 2024 | ISSN: 2320-2882 

IJCRT2406478 International Journal of Creative Research Thoughts (IJCRT) www.ijcrt.org e343 
 

forklifts. Depending on the type of forklift (e.g., diesel, propane, electric), fuel and energy costs can be 

significant. 

c. Limited Mobility- Forklifts may have difficulty accessing narrow or confined spaces, limiting their usability 

in some environments. Not all forklifts are suitable for all types of terrain. For example, standard forklifts 

may struggle on rough or uneven surfaces, requiring specialized models. 

d. Environmental Concerns- Diesel and propane forklifts produce emissions that can be harmful to the 

environment and indoor air quality. Some forklifts can be noisy, contributing to noise pollution in the 

workplace. 

e. Training Requirements- Proper training is essential for safe and efficient forklift operation, which can be 

time-consuming and costly. Operators may need to obtain certifications, depending on local regulations, 

adding to the administrative burden. 

f. Storage and Space- Forklifts themselves require storage space when not in use, which can be a challenge 

in smaller facilities. Warehouses and storage areas must have aisles wide enough to accommodate forklift 

operation, potentially reducing storage density. 

g. Wear and Tear- Forklifts are subject to significant wear and tear, especially tires, forks, and hydraulic 

systems, which can lead to frequent repairs. Forklifts depreciate over time, reducing their resale value. 

h. Load Limitations- Each forklift has a specific weight capacity, and exceeding this limit can be dangerous 

and lead to equipment failure. Improperly balanced or unstable loads can cause tipping or dropping of 

materials. 

i. Operational Limitations- Electric forklifts have limited battery life and require downtime for recharging, 

which can affect productivity. Battery-operated forklifts can have reduced performance in cold environments. 

j. Insurance and Liability- The potential for accidents and damage can lead to high insurance premiums for 

forklift operations. Companies can face significant liability issues in the event of forklift-related accidents, 

injuries, or property damage. 

Understanding these disadvantages can help businesses make informed decisions about forklift use and 

implement measures to mitigate these challenges. Proper training, regular maintenance, and adherence to 

safety protocols are essential for minimizing risks and maximizing the benefits of forklifts. 

 

2. LITERATURE REVIEW 

Khebude Karan N [1] examines the design and static structural analysis of a forklift fork using ANSYS R16.0. 

By comparing theoretical calculations with ANSYS results, the study highlights how using mild steel, with its 

high specific stiffness and strength, enhances fork performance by reducing deformation and bending under 

load. Mechanical forklifts have revolutionized the mechanical industry by enabling efficient material 

handling. Krunal R. Dhivar [2] allows a single operator to move thousands of pounds, enhancing safety and 

productivity. This prototype features remote technology for improved visibility and precision, increasing 

operator safety and accuracy. V. R. Gandhewar et al. [3] investigate that a forklift truck is a powered industrial 

vehicle for lifting and transporting materials. It operates on battery power, utilizing a lead screw mechanism 

for lifting. Our "Battery Operated Forklift" project aims to create a pollution-free, efficient forklift. By using 

battery power and a lead screw, the design enhances safety by allowing remote operation, which improves 

operator visibility and reduces human errors. This approach increases productivity and efficiency while 

minimizing environmental impact. Suryavanshi Amol V [4] investigated traditional forklifts have significant 

environmental impacts, such as carbon dioxide emissions and hydraulic fluid leaks. Integrating an electric 

system into a forklift makes it electrically powered, reducing the environmental impact of fuel-based forklifts. 

This technology also lessens human effort and errors, making it both user- and environmentally friendly. 
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Additionally, electric forklifts are highly affordable and cost-effective. Yadav et al. [5] describe a forklift 

powered by an electric motor using rechargeable batteries, aiming to design an electrically powered forklift 

for material handling in industrial warehouses and workshops. Traditional forklifts, operating on IC engines 

and hydraulic systems, cause environmental issues like carbon dioxide emissions and hydraulic fluid leaks. 

Our electric forklift addresses these problems, capable of lifting to 1 ton and elevating materials up to 8 feet, 

offering a cleaner and more efficient solution. Sudhakar et al. [6] designed for industrial applications, offers 

efficient mobility from one location to another. This system ensures the timely completion of tasks such as 

transporting goods, adhering to scheduled operations, and reducing cycle times. The carrier system 

optimizes productivity by minimizing the handling, fixing, and transit time traditionally wasted on moving 

goods. The saved time can be reallocated to enhance production processes, improving overall operational 

efficiency within the industrial environment. Panara et al. [7] utilize these devices, the efficiency of material 

handling is significantly improved, reducing manual labor and minimizing the time and effort involved in 

moving heavy loads. This enhances operational workflow and contributes to a safer and more organized 

work environment. 

3. OBJECTIVE 

This research aims to optimize the design of a manual forklift with a 500 kg load capacity by conducting a 

structural analysis using ANSYS software. The study evaluates four different materials: structural steel, gray 

cast iron, stainless steel, and aluminum alloy. Key parameters analyzed include directional deformation 

maximum, normal elastic strain, shear elastic strain, normal stress, and shear stress. The objective is to 

identify the most suitable material for the forklift structure by comparing these parameters, ensuring optimal 

performance and safety. The findings will guide the material selection process for improved durability and 

efficiency in manual forklift design. 

4. WORKING PRINCIPLE OF MANUAL FORKLIFT 

The manual forklift (Figure 1) operates on a simple yet effective principle, leveraging mechanical advantage 

to manually lift and transport heavy loads. Consisting of a sturdy frame with two forks extending from the 

front, the manual forklift is maneuvered by an operator who manually pumps a lever or rotates a handle to 

raise or lower the forks. This action engages a hydraulic system or a series of gears and pulleys, amplifying 

the force applied by the operator to lift the load. The forks slide beneath the load, which is then elevated by 

the lifting mechanism. The operator can then steer the forklift by maneuvering the handle or steering wheel, 

allowing precise load placement at its destination. The simplicity of its design enables the manual forklift to 

be versatile and easy to operate, making it suitable for various applications in warehouses, factories, and 

other industrial settings where heavy lifting is required.  
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Figure 1: 2D Schematic Diagram of Manual Forklift 
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5. BASIC METHOD 

Manual forklifts, or hand pallet jacks, are used to lift and move pallets within warehouses or other facilities. 

To understand the basic calculations involved in operating a manual forklift, we need to consider the 

following: 

 

a. Force Required to Lift a Load 

b. Force Required to Move a Load Horizontally 

c. Load Distribution and Stability 

a. Force Required to Lift a Load 

To lift a load using a manual forklift, you need to overcome the gravitational force acting on the load. This 

can be calculated using the formula: 

Flift = m.g                                                                                                                                                                                           

Where: 

Flift is the force required to lift the load (in Newtons, N). 

m is the mass of the load (in kilograms, kg). 

g is the acceleration due to gravity (approx. 9.81 m/s2). 

b. Force Required to Move a Load Horizontally 

To move a load horizontally, you need to overcome the rolling resistance. The force required can be 

calculated using: 

Fhorizontal = 𝜇.m.g                                                                                                                                       

Where: 

Fhorizontal is the force required to move the load horizontally (in Newtons, N). 

𝜇 is the coefficient of rolling resistance (dimensionless). For a typical hand pallet jack, this ranges from 0.01 

to 0.05. 

m is the mass of the load (in kilograms, kg). 

g is the acceleration due to gravity (approx. 9.81 m/s2). 

c. Load Distribution and Stability 

For stability and to avoid tipping over, ensure the load is evenly distributed and the center of gravity is low. 

The moment (torque) caused by the load should be less than the moment that would cause the forklift to 

tip. 

For example, assume you have a load of 500 kg on a manual forklift. Let’s calculate the force required to lift 

and move this load. 

Force to Lift the Load- 

m = 500 kg 

g = 9.81 m/s2 

Flift = 500 kg × 9.81 m/s2 
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Flift = 4905 N 

Force to Move the Load Horizontally- 

Assume  𝜇 = 0.02 (average rolling resistance for a manual pallet jack on a smooth surface): 

Fhorizontal = 0.02 × 500 kg × 9.81 m/s2 

Fhorizontal = 98.1 N 

So, we need 4905 N of force to lift the load vertically and 98.1 N of force to move it horizontally on a smooth 

surface. 

6. STRUCTURAL ANALYSIS PROCEDURE 

Here, we give the full procedure of structural analysis using ANSYS software. 

6.1 Material Properties Compositions  

a. Fork Material: Structural Steel 

Chemical Composition: 

Carbon (C) = 0.25% max 

Manganese (Mn) = 0.80% - 1.20% 

Phosphorus (P) = 0.04% max 

Sulfur (S) = 0.05% max 

Silicon (Si) = 0.40% max 

Copper (Cu) = 0.20% min (if specified for corrosion resistance) 

Mechanical Properties: 

Tensile Yield Strength (Syt) = 250 MPa  

Ultimate Tensile Strength (Sut) = 400 - 550 MPa  

Young's Modulus (E) = 200 GPa  

Poisson's Ratio (µ) = 0.26 

Density (ρ) = 7850 kg/m³ 

b. Fork Material: Gray Cast Iron 

Chemical Composition: 

Carbon (C) = 3.1% – 3.4% 

Silicon (Si) = 1.8% – 2.3% 

Manganese (Mn) = 0.5% – 0.7% 

Phosphorus (P) = 0.15% max 

Sulfur (S) = 0.15% max 

Iron (Fe) = Balance 

Mechanical Properties: 

Tensile Strength (Sut) = 276 MPa  
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Compressive Strength (Syc) = Typically higher than tensile strength, about 3-4 times the tensile      strength 

Young's Modulus (E) = 100 – 140 GPa (100,000 – 140,000 MPa) 

Poisson's Ratio (µ) = 0.26 

Density (ρ) = 6800 – 7200 kg/m³ 

c. Fork Material: Stainless Steel 

Chemical Composition: 

Carbon (C) = 0.08% max 

Manganese (Mn) = 2.00% max 

Phosphorus (P) = 0.045% max 

Sulfur (S) = 0.030% max 

Silicon (Si) = 0.75% max 

Chromium (Cr) = 18.00% – 20.00% 

Nickel (Ni) = 8.00% – 10.50% 

Nitrogen (N) = 0.10% max 

Iron (Fe) = Balance 

Mechanical Properties: 

Tensile Yield Strength (Syt) = 205 MPa  

Ultimate Tensile Strength (Sut) = 515 MPa  

Young's Modulus (E) = 193 GPa (193,000 MPa) 

Poisson's Ratio (µ) = 0.30 

Density (ρ) = 8000 kg/m³ 

d. Fork Material: Aluminum Alloy 

Chemical Composition: 

Aluminum (Al) = 95.8% – 98.6% 

Magnesium (Mg) = 0.8% – 1.2% 

Silicon (Si) = 0.4% – 0.8% 

Iron (Fe) = 0.0% – 0.7% 

Copper (Cu) = 0.15% – 0.40% 

Chromium (Cr) = 0.04% – 0.35% 

Zinc (Zn) = 0.0% – 0.25% 

Titanium (Ti) = 0.0% – 0.15% 

Manganese (Mn) = 0.0% – 0.15% 

Other = Each 0.05% max, Total 0.15% max 
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Mechanical Properties: 

Tensile Yield Strength (Syt) = 276 MPa  

Ultimate Tensile Strength (Sut) = 310 MPa  

Compressive Yield Strength (Syc) = Approximately 276 MPa  

Young's Modulus (E) = 69 GPa (69,000 MPa) 

Poisson's Ratio (µ) = 0.33 

Density (ρ) = 2700 kg/m³ 

6.2 Steps for Structural Analysis Using ANSYS 

a. Open ANSYS and Select Static Structural Analysis 

Open the ANSYS Workbench. 

Drag and drop the "Static Structural" module into the Project Schematic. 

b. Enter the Engineering Data of the Material (Mild Steel) 

Double-click on "Engineering Data" in the Project Schematic. 

Add a new material if not already available. 

Enter the material properties. 

c. Select Geometry and Import the Model 

Double-click on "Geometry" in the Project Schematic. 

Import your model in .stp or .igs format: 

Go to File > Import External Geometry File. 

Select your .stp or .igs file and click Open. 

Generate the geometry: 

Click on "Generate" to confirm the geometry import. 

d. Set Up the Mesh 

Double-click on "Model" to open the Mechanical module. 

In the Mechanical module, select "Mesh" from the Outline tree. 

Apply face sizing and set the mesh method: 

Right-click on "Mesh" > Insert > Sizing. 

Select the faces where you want to apply sizing and specify the element size. 

Set the method to "Path Conforming". 

e. Apply Boundary Conditions 

Apply fixed support: 

Right-click on "Static Structural" > Insert > Fixed Support. 

Select the faces or edges where the support should be applied. 
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Apply force in the Z direction: 

Right-click on "Static Structural" > Insert > Force. 

Select the face or area where the force should be applied. 

Specify the magnitude and direction of the force (Z direction). 

f. Generate and Observe the Mesh 

Click on "Mesh" in the Outline tree. 

Click on "Generate Mesh" to create the mesh. 

Observe the mesh view to ensure proper element distribution. 

g. Insert and Review Results 

Insert the required results: 

Right-click on "Solution" in the Outline tree > Insert > Deformation > Total. 

Right-click on "Solution" > Insert > Stress > Equivalent (von Mises). 

Solve the analysis: 

Click on "Solve" to run the simulation. 

Review the results: 

Check the total deformation, stress distributions, and any other inserted results. 

This standard procedure for structural analysis in ANSYS covers the essential steps to set up and analyze a 

static structural problem using Mild Steel as the material. Ensure all inputs and settings are correct before 

simulating to obtain accurate results. 
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7. ANALYSIS OF RESULTS 

7.1 CAD Design Model: 

 

Figure 2: CAD Design Model of Manual Forklift 
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7.2 Analysis Model: 

 

Figure 3: Meshing Model of Fork Using ANSYS 

 

Figure 4: Analysis of Fork Using ANSYS 

 

 

 

 

 

 

 

 

http://www.ijcrt.org/


www.ijcrt.org                                                          © 2024 IJCRT | Volume 12, Issue 6 June 2024 | ISSN: 2320-2882 

IJCRT2406478 International Journal of Creative Research Thoughts (IJCRT) www.ijcrt.org e353 
 

7.3 Results of Analysis: 

a. We analyzed a design with various materials and their independent variables. The dimensions of the 
design are as follows: width of 101.68 mm, thickness of 38.1 mm, and length of 990.6 mm. 

Table 1: Result for ITA = 254 

Material Directional 
Deformation 
Maximum 
(mm) 

Normal 
Elastic Strain 
(mm/mm) 

Shear Elastic 
Strain 
(mm/mm) 

Normal 
Stress (MPa) 

Shear Stress 
(MPa) 

Structural 
Steel 

1.03 × 10-2 Max= 2.9 × 
10-4 

Min= -1.9 × 
10-4 

Avg.= 7.1 × 
10-7 

Max= 1.8 × 
10-4 

Min= -1.8 × 
10-4 

Avg.= -1.55 
×10-7 

Max= 54.3 

Min= -47.8 

Avg.= 0.378 

Max= 14.05 

Min= -14.46 

Avg.= -1.2 
×10-2 

Gray Cast 
Iron 

1.81 × 10-2 Max= 4.2 × 
10-4 

Min= -3.7 × 
10-4 

Avg.= 1.07 
×10-7 

Max= 2.7 × 
10-4 

Min= -2.5 × 
10-4 

Avg.= 2.9 
×10-7 

Max= 49.08 

Min= -48.7 

Avg.= 0.116 

Max= 11.67 

Min= -11.17 

Avg.= 1.2 
×10-2 

Stainless 
Steel 

1.1 × 10-2 Max= 2.4 × 
10-4 

Min= -2.1 × 
10-4 

Avg.= 2.1 
×10-9 

Max= 1.6 × 
10-4 

Min= -1.5 × 
10-4 

Avg.= 1.7 
×10-7 

Max= 49.50 

Min= -49.42 

Avg.= 0.116 

Max= 11.71 

Min= -11.3 

Avg.= 1.26 
×10-2 

Aluminium 
Alloy 

3.15 × 10-2 Max= 6.9 × 
10-4 

Min= -5.3 × 
10-4 

Avg.= 1.6 
×10-6 

Max= 5.2 × 
10-4 

Min= -5.4 × 
10-4 

Avg.= -4.4 
×10-7 

Max= 54.6 

Min= -48.34 

Avg.= 0.382 

Max= 14.09 

Min= -14.61 

Avg.= -1.18 
×10-2 

 

 

 

 

 

 

http://www.ijcrt.org/


www.ijcrt.org                                                          © 2024 IJCRT | Volume 12, Issue 6 June 2024 | ISSN: 2320-2882 

IJCRT2406478 International Journal of Creative Research Thoughts (IJCRT) www.ijcrt.org e354 
 

Table 2: Result for ITA = 266.7 

Material Directional 
Deformation 
Maximum 
(mm) 

Normal 
Elastic Strain 
(mm/mm) 

Shear Elastic 
Strain 
(mm/mm) 

Normal 
Stress (MPa) 

Shear Stress 
(MPa) 

Structural 
Steel 

5.8 × 10-2 Max= 2.6 × 
10-4 

Min= -2.7 × 
10-4 

Avg.= 5.5 
×10-7 

Max= 2 × 
10-4 

Min= -1.7 × 
10-4 

Avg.= -5.6 
×10-8 

Max= 54.9 

Min= -65.2 

Avg.= 0.353 

Max= 15.76 

Min= -13.24 

Avg.= -4.3 
×10-3 

Gray Cast 
Iron 

0.1068 Max= 4.7 × 
10-4 

Min= -5.03 × 
10-4 

Avg.= 1.1 
×10-6 

Max= 3.6 × 
10-4 

Min= -3.07 × 
10-4 

Avg.= -1.04 
×10-7 

Max= 54.7 

Min= -64.5 

Avg.= 0.350 

Max= 15.70 

Min= -13.20 

Avg.= -4.51 
×10-3 

Stainless 
Steel 

6.08 × 10-2 Max= 2.7 × 
10-4 

Min= -2.8 × 
10-4 

Avg.= 5.3 
×10-7 

Max= 2.1 × 
10-4 

Min= -1.79 × 
10-4 

Avg.= -5.8 
×10-8 

Max= 55.03 

Min= -65.56 

Avg.= 0.354 

Max= 15.79 

Min= -13.20 

Avg.= -4.31 
×10-3 

Aluminium 
Alloy 

0.1068 Max= 7.3 × 
10-4 

Min= -7.4 × 
10-4 

Avg.= 1.24 
×10-6 

Max= 5.9 × 
10-4 

Min= -4.97 × 
10-4 

Avg.= -1.6 
×10-7 

Max= 55.2 

Min= -66.32 

Avg.= 0.357 

Max= 15.85 

Min= -13.20 

Avg.= -4.18 
×10-3 
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Table 3: Result for ITA = 279.4 

Material Directional 
Deformation 
Maximum 
(mm) 

Normal 
Elastic Strain 
(mm/mm) 

Shear Elastic 
Strain 
(mm/mm) 

Normal 
Stress (MPa) 

Shear Stress 
(MPa) 

Structural 
Steel 

1.03 × 10-2 Max= 2.48 × 
10-4 

Min= -2.55 × 
10-4 

Avg.= 8.5 
×10-7 

Max= 2.55 × 
10-4 

Min= -1.8 × 
10-4 

Avg.= -2.1 
×10-7 

Max= 55.3 

Min= -61.57 

Avg.= 0.426 

Max= 19.68 

Min= -14.08 

Avg.= -1.62 
×10-2 

Gray Cast 
Iron 

1.78 × 10-2 Max= 4.52 × 
10-4 

Min= -4.71 × 
10-4 

Avg.= 1.7 
×10-6 

Max= 4.56 × 
10-4 

Min= -3.28 × 
10-4 

Avg.= -3.7 
×10-7 

Max= 55.08 

Min= -60.98 

Avg.= 0.422 

Max= 19.62 

Min= -14.12 

Avg.= -
1.62×10-2 

Stainless 
Steel 

1.1 × 10-2 Max= 2.54 × 
10-4 

Min= -2.62 × 
10-4 

Avg.= 8.4 
×10-7 

Max= 2.67 × 
10-4 

Min= -1.91 × 
10-4 

Avg.= -2.1 
×10-7 

Max= 55.43 

Min= -61.9 

Avg.= 0.427 

Max= 19.7 

Min= -14.07 

Avg.= -1.61 
×10-2 

Aluminium 
Alloy 

3.15 × 10-2 Max= 6.98 × 
10-4 

Min= -6.99 × 
10-4 

Avg.= 2.08 
×10-6 

Max= 7.4 × 
10-4 

Min= -5.25 × 
10-4 

Avg.= -6 
×10-7 

Max= 55.64 

Min= -62.59 

Avg.= 0.430 

Max= 19.75 

Min= -14.03 

Avg.= -1.61 
×10-2 
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Table 4: Result for ITA = 292.1 

Material Directional 
Deformation 
Maximum 
(mm) 

Normal 
Elastic Strain 
(mm/mm) 

Shear Elastic 
Strain 
(mm/mm) 

Normal 
Stress (MPa) 

Shear Stress 
(MPa) 

Structural 
Steel 

1.03 × 10-2 Max= 2.34 × 
10-4 

Min= -2.91 × 
10-4 

Avg.= 4.74 
×10-7 

Max= 2.16 × 
10-4 

Min= -1.9 × 
10-4 

Avg.= -1.5 
×10-7 

Max= 55.42 

Min= -69.81 

Avg.= 0.344 

Max= 16.62 

Min= -14.64 

Avg.= -1.16 
×10-2 

Gray Cast 
Iron 

1.78 × 10-2 Max= 4.26 × 
10-4 

Min= -5.36 × 
10-4 

Avg.= 9.9 
×10-7 

Max= 3.85 × 
10-4 

Min= -3.4 × 
10-4 

Avg.= -2.72 
×10-7 

Max= 55.10 

Min= -69.19 

Avg.= 0.341 

Max= 16.57 

Min= -14.62 

Avg.= -1.17 
×10-2 

Stainless 
Steel 

3.16 × 10-2 Max= 6.57 × 
10-4 

Min= -7.93 × 
10-4 

Avg.= 1.01 
×10-6 

Max= 6.25 × 
10-4 

Min= -5.4 × 
10-4 

Avg.= -4.3 
×10-7 

Max= 55.87 

Min= -70.86 

Avg.= 0.349 

Max= 16.69 

Min= -14.67 

Avg.= -1.14 
×10-2 

Aluminium 
Alloy 

1.1 × 10-2 Max= 2.42 × 
10-4 

Min= -2.97 × 
10-4 

Avg.= 4.52 
×10-7 

Max= 2.26 × 
10-4 

Min= -1.99 × 
10-4 

Avg.= -
1.5×10-7 

Max= 55.58 

Min= -70.15 

Avg.= 0.346 

Max= 16.65 

Min= -14.66 

Avg.= -1.15 
×10-2 
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Table 5: Result for ITA = 304 

Material Directional 
Deformation 
Maximum 
(mm) 

Normal 
Elastic Strain 
(mm/mm) 

Shear Elastic 
Strain 
(mm/mm) 

Normal 
Stress (MPa) 

Shear Stress 
(MPa) 

Structural 
Steel 

1.03 × 10-2 Max= 2.4 × 
10-4 

Min= -2.89 × 
10-4 

Avg.= 3.1 
×10-7 

Max= 1.77 × 
10-4 

Min= -1.72 × 
10-4 

Avg.= -1.4 
×10-7 

Max= 53.85 

Min= -69.16 

Avg.= 0.307 

Max= 13.62 

Min= -13.27 

Avg.= -1.10 
×10-2 

Gray Cast 
Iron 

1.1 × 10-2 Max= 2.53 × 
10-4 

Min= -2.97 × 
10-4 

Avg.= 
2.82×10-7 

Max= 1.84 × 
10-4 

Min= -1.8 × 
10-4 

Avg.= -
1.4×10-7 

Max= 53.95 

Min= -69.54 

Avg.= 0.308 

Max= 13.62 

Min= -13.28 

Avg.= -1.09 
×10-2 

Stainless 
Steel 

1.78 × 10-2 Max= 4.45 × 
10-4 

Min= -5.34 × 
10-4 

Avg.= 7 ×10-

7 

Max= 3.16 × 
10-4 

Min= -3.08 × 
10-4 

Avg.= -2.5 
×10-7 

Max= 53.61 

Min= -69.47 

Avg.= 0.305 

Max= 13.61 

Min= -13.25 

Avg.= -1.11 
×10-2 

Aluminium 
Alloy 

3.15 × 10-2 Max= 6.36 × 
10-4 

Min= -7.95 × 
10-4 

Avg.= 5.4 
×10-7 

Max= 5.1 × 
10-4 

Min= -4.98× 
10-4 

Avg.= -4.05 
×10-7 

Max= 54.15 

Min= -70.34 

Avg.= 0.311 

Max= 13.62 

Min= -13.30 

Avg.= -1.08 
×10-2 
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Table 6: Result for ITA = 317.5 

Material Directional 
Deformation 
Maximum 
(mm) 

Normal 
Elastic Strain 
(mm/mm) 

Shear Elastic 
Strain 
(mm/mm) 

Normal 
Stress (MPa) 

Shear Stress 
(MPa) 

Structural 
Steel 

1.02 × 10-2 Max= 2.47 × 
10-4 

Min= -2.69 × 
10-4 

Avg.= 4.5 
×10-7 

Max= 1.82 × 
10-4 

Min= -1.86 × 
10-4 

Avg.= -2.6 
×10-7 

Max= 53.42 

Min= -65.21 

Avg.= 0.337 

Max= 14.17 

Min= -14.30 

Avg.= -2.01 
×10-2 

Gray Cast 
Iron 

3.13 × 10-2 Max= 6.96 × 
10-4 

Min= -7.37 × 
10-4 

Avg.= 9.4 
×10-7 

Max= 5.08 × 
10-4 

Min= -5.30 × 
10-4 

Avg.= -7.4 
×10-7 

Max= 53.71 

Min= -66.33 

Avg.= 0.342 

Max= 13.57 

Min= -14.37 

Avg.= -2 
×10-2 

Stainless 
Steel 

1.77 × 10-2 Max= 4.51 × 
10-4 

Min= -4.97 × 
10-4 

Avg.= 9.5 
×10-7 

Max= 3.39 × 
10-4 

Min= -3.31 × 
10-4 

Avg.= -4.7 
×10-7 

Max= 53.22 

Min= -64.55 

Avg.= 0.335 

Max= 14.57 

Min= -14.25 

Avg.= -2.03 
×10-2 

Aluminium 
Alloy 

1.09 × 10-2 Max= 2.56 × 
10-4 

Min= -2.76 × 
10-4 

Avg.= 4.2 
×10-7 

Max= 1.89 × 
10-4 

Min= -1.94 × 
10-4 

Avg.= -2.7 
×10-7 

Max= 53.50 

Min= -65.57 

Avg.= 0.339 

Max= 13.97 

Min= -14.33 

Avg.= -2.01 
×10-2 
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Table 7: Result for ITA = 330.2 

Material Directional 
Deformation 
Maximum 
(mm) 

Normal 
Elastic Strain 
(mm/mm) 

Shear Elastic 
Strain 
(mm/mm) 

Normal 
Stress (MPa) 

Shear Stress 
(MPa) 

Structural 
Steel 

1.03 × 10-2 Max= 2.61 × 
10-4 

Min= -2.3 × 
10-4 

Avg.= 4.14 
×10-7 

Max= 2.03 × 
10-4 

Min= -1.88 × 
10-4 

Avg.= -9.7 
×10-8 

Max= 54.32 

Min= -56.98 

Avg.= 0.334 

Max= 15.68 

Min= -14.48 

Avg.= -7.49 
×10-3 

Gray Cast 
Iron 

1.78 × 10-2 Max= 4.76 × 
10-4 

Min= -4.3 × 
10-4 

Avg.= 8.94 
×10-7 

Max= 3.63 × 
10-4 

Min= -3.35 × 
10-4 

Avg.= -1.7 
×10-7 

Max= 54.44 

Min= -56.53 

Avg.= 0.331 

Max= 15.63 

Min= -14.41 

Avg.= -7.63 
×10-3 

Stainless 
Steel 

3.16 × 10-2 Max= 7.35 × 
10-4 

Min= -6.4 × 
10-4 

Avg.= 8.39 
×10-7 

Max= 5.9 × 
10-4 

Min= -5.46 × 
10-4 

Avg.= -2.7 
×10-7 

Max= 55.11 

Min= -57.75 

Avg.= 0.339 

Max= 15.76 

Min= -14.58 

Avg.= -7.27 
×10-3 

Aluminium 
Alloy 

1.10 × 10-2 Max= 2.7 × 
10-4 

Min= -2.4 × 
10-4 

Avg.= 3.89 
×10-7 

Max= 2.1 × 
10-4 

Min= -1.9 × 
10-4 

Avg.= -1 
×10-7 

Max= 54.86 

Min= -57.23 

Avg.= 0.336 

Max= 15.71 

Min= -14.51 

Avg.= -7.42 
×10-3 

b. We analyzed a design with various materials and their independent variables. The dimensions of the 
design are as follows: width of 101.68 mm, thickness of 38.1 mm, and length of 1016 mm. 
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Table 8: Result for ITA = 254 

Material Directional 
Deformation 
Maximum 
(mm) 

Normal 
Elastic Strain 
(mm/mm) 

Shear Elastic 
Strain 
(mm/mm) 

Normal 
Stress (MPa) 

Shear Stress 
(MPa) 

Structural 
Steel 

1.11 × 10-2 Max= 2.59 × 
10-4 

Min= -2.84 × 
10-4 

Avg.= 1.46 
×10-6 

Max= 1.76 × 
10-4 

Min= -2.67 × 
10-4 

Avg.= -3.7 
×10-7 

Max= 57.62 

Min= -69.29 

Avg.= 0.538 

Max= 13.60 

Min= -20.51 

Avg.= -2.91 
×10-2 

Gray Cast 
Iron 

3.38 × 10-2 Max= 7.29 × 
10-4 

Min= -7.75 × 
10-4 

Avg.= 3.80 
×10-6 

Max= 5.13 × 
10-4 

Min= -7.69 × 
10-4 

Avg.= -1.08 
×10-6 

Max= 58.13 

Min= -70.35 

Avg.= 0.542 

Max= 13.71 

Min= -20.54 

Avg.= -2.90 
×10-2 

Stainless 
Steel 

1.91 × 10-2 Max= 4.71 × 
10-4 

Min= -5.26 × 
10-4 

Avg.= 2.79 
×10-6 

Max= 3.15 × 
10-4 

Min= -4.76 × 
10-4 

Avg.= -6.7 
×10-7 

Max= 57.27 

Min= -68.65 

Avg.= 0.535 

Max= 13.54 

Min= -20.49  

Avg.= -2.91 
×10-2 

Aluminium 
Alloy 

1.18 × 10-2 Max= 2.68 × 
10-4 

Min= -2.91 × 
10-4 

Avg.= 1.47 
×10-6 

Max= 1.85 × 
10-4 

Min= -2.78 × 
10-4 

Avg.= -3.94 
×10-7 

Max= 57.79 

Min= -69.63 

Avg.= 0.539 

Max= 13.64 

Min= -20.52 

Avg.= -2.90 
×10-2 

 

 

 

 

 

 

 

 

http://www.ijcrt.org/


www.ijcrt.org                                                          © 2024 IJCRT | Volume 12, Issue 6 June 2024 | ISSN: 2320-2882 

IJCRT2406478 International Journal of Creative Research Thoughts (IJCRT) www.ijcrt.org e361 
 

Table 9: Result for ITA = 266.7 

Material Directional 
Deformation 
Maximum 
(mm) 

Normal 
Elastic Strain 
(mm/mm) 

Shear Elastic 
Strain 
(mm/mm) 

Normal 
Stress (MPa) 

Shear Stress 
(MPa) 

Structural 
Steel 

1.09 × 10-2 Max= 2.57 × 
10-4 

Min= -2.8 × 
10-4 

Avg.= 1.65 
×10-6 

Max= 2.08 × 
10-4 

Min= -2.05 × 
10-4 

Avg.= -1.71 
×10-7 

Max= 57.25 

Min= -68.14 

Avg.= 0.58 

Max= 16.01 

Min= -15.82 

Avg.= -1.31 
×10-2 

Gray Cast 
Iron 

3.34 × 10-2 Max= 7.23 × 
10-4 

Min= -7.67 × 
10-4 

Avg.= 4.33 
×10-6 

Max= 6.01 × 
10-4 

Min= -5.93 × 
10-4 

Avg.= -4.8 
×10-7 

Max= 57.70 

Min= -69.18 

Avg.= 0.59 

Max= 16.04 

Min= -15.84 

Avg.= -1.24 
×10-2 

Stainless 
Steel 

1.89 × 10-2 Max= 4.67 × 
10-4 

Min= -5.19 × 
10-4 

Avg.= 3.15 
×10-6 

Max= 3.71 × 
10-4 

Min= -3.67 × 
10-4 

Avg.= -3.11 
×10-7 

Max= 56.94 

Min= -67.52 

Avg.= 0.58 

Max= 15.98 

Min= -15.79 

Avg.= -1.33 
×10-2 

Aluminium 
Alloy 

1.16 × 10-2 Max= 2.66 × 
10-4 

Min= -2.88 × 
10-4 

Avg.= 1.67 
×10-6 

Max= 2.17 × 
10-4 

Min= -2.14 × 
10-4 

Avg.= -1.7 
×10-7 

Max= 57.40 

Min= -68.47 

Avg.= 0.58 

Max= 16.02 

Min= -15.83 

Avg.= -1.3 
×10-2 
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Table 10: Result for ITA = 279.4 

Material Directional 
Deformation 
Maximum 
(mm) 

Normal 
Elastic Strain 
(mm/mm) 

Shear Elastic 
Strain 
(mm/mm) 

Normal 
Stress (MPa) 

Shear Stress 
(MPa) 

Structural 
Steel 

1.09 × 10-2 Max= 2.43 × 
10-4 

Min= -2.42 × 
10-4 

Avg.= 1.34 
×10-6 

Max= 1.62× 
10-4 

Min= -2.74 × 
10-4 

Avg.= -4.9 
×10-7 

Max= 56.75 

Min= -57.83 

Avg.= 0.51 

Max= 12.51 

Min= -21.13 

Avg.= -3.7 
×10-2 

Gray Cast 
Iron 

3.36 × 10-2 Max= 6.82 × 
10-4 

Min= -6.65 × 
10-4 

Avg.= 3.46 
×10-6 

Max= 4.67 × 
10-4 

Min= -7.94 × 
10-4 

Avg.= -1.41 
×10-6 

Max= 57.19 

Min= -58.82 

Avg.= 0.51 

Max= 12.47 

Min= -21.21 

Avg.= -3.78 
×10-2 

Stainless 
Steel 

1.89 × 10-2 Max= 4.43 × 
10-4 

Min= -4.47 × 
10-4 

Avg.= 2.58 
×10-6 

Max= 2.91 × 
10-4 

Min= -4.90 × 
10-4 

Avg.= -8.77 
×10-7 

Max= 56.45 

Min= -57.25 

Avg.= 0.51 

Max= 12.53 

Min= -21.08 

Avg.= -3.76 
×10-2 

Aluminium 
Alloy 

1.67 × 10-2 Max= 2.51 × 
10-4 

Min= -2.49 × 
10-4 

Avg.= 1.35 
×10-6 

Max= 1.69 × 
10-4 

Min= -2.87 × 
10-4 

Avg.= -5.1 
×10-7 

Max= 56.91 

Min= -58.14 

Avg.= 0.51 

Max= 12.50 

Min= -21.16 

Avg.= -3.78 
×10-2 
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Table 11: Result for ITA = 292.1 

Material Directional 
Deformation 
Maximum 
(mm) 

Normal 
Elastic Strain 
(mm/mm) 

Shear Elastic 
Strain 
(mm/mm) 

Normal 
Stress (MPa) 

Shear Stress 
(MPa) 

Structural 
Steel 

1.09 × 10-2 Max= 2.56 × 
10-4 

Min= -2.16 × 
10-4 

Avg.= 1.32 
×10-6 

Max= 1.76× 
10-4 

Min= -1.9 × 
10-4 

Avg.= -2.3 
×10-7 

Max= 54.27 

Min= -52.56 

Avg.= 0.50 

Max= 13.58 

Min= -14.67 

Avg.= -1.84 
×10-2 

Gray Cast 
Iron 

3.33 × 10-2 Max= 7.21 × 
10-4 

Min= -5.4 × 
10-4 

Avg.= 3.42 
×10-6 

Max= 5.1 × 
10-4 

Min= -5.54 × 
10-4 

Avg.= -6.9 
×10-7 

Max= 54.58 

Min= -53.24 

Avg.= 0.50 

Max= 13.61 

Min= -14.79 

Avg.= -1.84 
×10-2 

Stainless 
Steel 

1.89 × 10-2 Max= 4.67 × 
10-4 

Min= -3.9 × 
10-4 

Avg.= 2.5 
×10-6 

Max= 3.15 × 
10-4 

Min= -3.39 × 
10-4 

Avg.= -4.2 
×10-7 

Max= 54.02 

Min= -52.14 

Avg.= 0.50 

Max= 13.56 

Min= -14.58 

Avg.= -1.84 
×10-2 

Aluminium 
Alloy 

1.16 × 10-2 Max= 2.65 × 
10-4 

Min= -2.21 × 
10-4 

Avg.= 1.33 
×10-6 

Max= 1.85 × 
10-4 

Min= -2 × 
10-4 

Avg.= -2.5 
×10-7 

Max= 54.38 

Min= -52.71 

Avg.= 0.50 

Max= 13.59 

Min= -14.70 

Avg.= -1.84 
×10-2 
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Table 12: Result for ITA = 304 

Material Directional 
Deformation 
Maximum 
(mm) 

Normal 
Elastic Strain 
(mm/mm) 

Shear Elastic 
Strain 
(mm/mm) 

Normal 
Stress (MPa) 

Shear Stress 
(MPa) 

Structural 
Steel 

1.09 × 10-2 Max= 2.4 × 
10-4 

Min= -3.4 × 
10-4 

Avg.= 1.5 
×10-6 

Max= 2.51× 
10-4 

Min= -1.88 × 
10-4 

Avg.= 2.75 
×10-8 

Max= 56.11 

Min= -82.31 

Avg.= 0.55 

Max= 19.33 

Min= -14.46 

Avg.= 2.11 
×10-3 

Gray Cast 
Iron 

3.33 × 10-2 Max= 6.78 × 
10-4 

Min= -9.32 × 
10-4 

Avg.= 3.9 
×10-6 

Max= 7.29 × 
10-4 

Min= -5.42 × 
10-4 

Avg.= 7.83 
×10-8 

Max= 56.49 

Min= -83.56 

Avg.= 0.55 

Max= 19.47 

Min= -14.48 

Avg.= 2.09 
×10-3 

Stainless 
Steel 

1.88 × 10-2 Max= 4.37 × 
10-4 

Min= -6.32 × 
10-4 

Avg.= 2.86 
×10-6 

Max= 4.47 × 
10-4 

Min= -3.35 × 
10-4 

Avg.= 4.9 
×10-8 

Max= 55.84 

Min= -81.58 

Avg.= 0.54 

Max= 19.24 

Min= -14.43 

Avg.= 2.14 
×10-3 

Aluminium 
Alloy 

1.16 × 10-2 Max= 2.49 × 
10-4 

Min= -3.5 × 
10-4 

Avg.= 1.51 
×10-6 

Max= 2.63 × 
10-4 

Min= -1.96 × 
10-4 

Avg.= 2.8 
×10-8 

Max= 56.24 

Min= -82.71 

Avg.= 0.55 

Max= 19.38 

Min= -14.47 

Avg.= 2.10 
×10-3 
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Table 13: Result for ITA = 317.5 

Material Directional 
Deformation 
Maximum 
(mm) 

Normal 
Elastic Strain 
(mm/mm) 

Shear Elastic 
Strain 
(mm/mm) 

Normal 
Stress (MPa) 

Shear Stress 
(MPa) 

Structural 
Steel 

1.09 × 10-2 Max= 2.56 × 
10-4 

Min= -3.46 × 
10-4 

Avg.= 1.64 
×10-6 

Max= 2.11× 
10-4 

Min= -1.96 × 
10-4 

Avg.= -5.76 
×10-8 

Max= 56.62 

Min= -83.51 

Avg.= 0.58 

Max= 16.29 

Min= -15.15 

Avg.= -4.43 
×10-3 

Gray Cast 
Iron 

3.34 × 10-2 Max= 7.21 × 
10-4 

Min= -9.46 × 
10-4 

Avg.= 4.3 
×10-6 

Max= 6.13 × 
10-4 

Min= -5.69 × 
10-4 

Avg.= -1.7 
×10-7 

Max= 56.87 

Min= -84.78 

Avg.= 0.58 

Max= 16.36 

Min= -15.19 

Avg.= -4.59 
×10-3 

Stainless 
Steel 

1.89 × 10-2 Max= 4.67 × 
10-4 

Min= -6.41 × 
10-4 

Avg.= 3.13 
×10-6 

Max= 3.78 × 
10-4 

Min= -3.51 × 
10-4 

Avg.= -1 
×10-7 

Max= 56.40 

Min= -82.76 

Avg.= 0.58 

Max= 16.24 

Min= -15.11 

Avg.= -4.33 
×10-3 

Aluminium 
Alloy 

1.16 × 10-2 Max= 2.65 × 
10-4 

Min= -3.55 × 
10-4 

Avg.= 1.67 
×10-6 

Max= 2.21 × 
10-4 

Min= -2.05 × 
10-4 

Avg.= -6.09 
×10-8 

Max= 56.71 

Min= -83.91 

Avg.= 0.58 

Max= 16.32 

Min= -15.16 

Avg.= -4.48 
×10-3 
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Table 14: Result for ITA = 330.2 

Material Directional 
Deformation 
Maximum 
(mm) 

Normal 
Elastic Strain 
(mm/mm) 

Shear Elastic 
Strain 
(mm/mm) 

Normal 
Stress (MPa) 

Shear Stress 
(MPa) 

Structural 
Steel 

1.1 × 10-2 Max= 2.44 × 
10-4 

Min= -2.34 × 
10-4 

Avg.= 1.18 
×10-6 

Max= 1.87 × 
10-4 

Min= -2.24 × 
10-4 

Avg.= -3.7 
×10-7 

Max= 57.82 

Min= -57.34 

Avg.= 0.48 

Max= 14.41 

Min= -18.01 

Avg.= -2.85 
×10-2 

Gray Cast 
Iron 

3.35 × 10-2 Max= 6.88 × 
10-4 

Min= -6.36 × 
10-4 

Avg.= 3.01 
×10-6 

Max= 5.41 × 
10-4 

Min= -6.76 × 
10-4 

Avg.= -1.06 
×10-6 

Max= 58.25 

Min= -57.88 

Avg.= 0.48 

Max= 14.45 

Min= -18.06 

Avg.= -2.84 
×10-2 

Stainless 
Steel 

1.89 × 10-2 Max= 4.45 × 
10-4 

Min= -4.35 × 
10-4 

Avg.= 2.28 
×10-6 

Max= 3.34 × 
10-4 

Min= -4.18 × 
10-4 

Avg.= -6.64 
×10-7 

Max= 57.53 

Min= -57.02 

Avg.= 0.47 

Max= 14.37 

Min= -17.97 

Avg.= -2.85 
×10-2 

Aluminium 
Alloy 

1.17 × 10-2 Max= 2.53 × 
10-4 

Min= -2.4 × 
10-4 

Avg.= 1.18 
×10-6 

Max= 1.95× 
10-4 

Min= -2.44 × 
10-4 

Avg.= -3.8 
×10-7 

Max= 57.97 

Min= -57.51 

Avg.= 0.48 

Max= 14.42 

Min= -18.03 

Avg.= -2.84 
×10-2 

 

8. CONCLUSION 

The use of various materials for forklift forks results in minimal deformation, with mild steel demonstrating 

superior wear resistance and impact strength. The theoretical calculations, verified against ANSYS results, 

confirm the safety and reliability of these findings. The development of mechanical forklifts enhances 

ergonomic comfort for operators, significantly reducing the time needed for manual lifting and handling. 

These forklifts are capable of lifting loads to 500 kg at an ITA (Industrial Truck Association) rating of 990.6 

mm and 1016 mm, thereby boosting productivity and ensuring operator safety during material handling 

tasks. The integration of these advanced features standardizes the forklift design, making it a robust and 

efficient tool in industrial applications. 
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9. FUTURE SCOPE 

The future scope of manual forklifts includes significant advancements in ergonomic design, lightweight 

materials, and enhanced safety features. Innovations such as hybrid models that combine manual and 

motorized functions could emerge, offering greater versatility and ease of use. Additionally, integrating smart 

technology like IoT sensors and automated tracking systems can optimize inventory management and 

maintenance schedules. As sustainability becomes a priority, the development of eco-friendly materials and 

energy-efficient designs will likely gain traction. Overall, these advancements will make manual forklifts more 

efficient, user-friendly, and aligned with modern industrial and environmental standards. 
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